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It was great to gather 

in Austin, Texas at the 

end of February for the 

40th annual Ortho2 

Users Group Meeting! 

This meeting is always 

a wonderful event, and 

somehow keeps getting 

better each time we have 

it. The UGM opened 

with Drew Humphrey, 

Ortho2 Sales and 

Enterprise Manager, and 

myself discussing the 
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orthodontic landscape and how Ortho2 reacts and evolves 

with it. Aaron Smalls gave a phenomenal keynote address 

titled The Sound of Leadership, offering a fresh perspective 

on navigating the complexities of leading through change. 

Over the next two and a half days, attendees participated 

in more than 40 classes led by Ortho2 team members and 

26 industry-leading orthodontic consultants and doctors. 

The event fostered incredible team-building and networking 

opportunities—both among offices and with the Ortho2 

team. And of course, the Ortho2 World Tour party on Friday 

night was a hit!

But what’s better than one meeting in Austin? Two meetings 

of course! The meeting continued Saturday afternoon with 

an Ortho2 Development Conference. This was the 16th 

annual ODC and was attended by doctors, team members, 

and many from the Ortho2 team to help shape the future of 

Ortho2 development. We discussed a number of features 

about to be released, like significant Edge Reminders and 

Edge Signature enhancements as well as adding existing 

patient self-scheduling. This conference is a great way for our 

product development team to hear directly from our users.

And the Ortho2 team isn’t done. Beyond hosting the Users 

Group Meeting and Ortho2 Development Conference, 

Ortho2 is gearing up for the largest industry event we 

attend—the American Association of Orthodontists (AAO) 

meeting. Behind the scenes, our team has been working hard 

to secure a prime booth location, plan for booth updates, 

finalize travel logistics, and much more. We are gearing up 

for a great AAO in Philadelphia. If you’re planning to be in 

Philly, please stop by to say hello and see what new features 

you can look to incorporate 

into your practice soon! 

Ortho2 Perspective continued from previous page

Amy Schmidt, Ortho2 President

Amy Schmidt

2025 Users Group Meeting Recap

Thank you to everyone who attended the 2025 UGM in Austin! We had such a wonderful time connecting with you,  
sharing knowledge, and celebrating the orthodontic community! Did you miss out on this year’s action? Fill out the  
form at go.ortho2.com/ugm2026 to be in the loop about next year’s virtual meeting.
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A s I’m sure you are already aware, there are a lot of 

reports in Edge Cloud. I’m sure you are also aware that 

it can be a little overwhelming to try and find the right one 

for what you need. So, I would like to take some time to talk 

about some of the basic financial reports that every practice 

should be looking over at least once a month or so. 

Daily Transactions Report Summary
You can’t start a conversation about financials without 

beginning with the Daily Transactions Report Summary. This 

is the building block for most other financial reports, so this 

report must be studied daily. You want to ensure that you 

have verified for accuracy what is on this report and finalize 

it every day.

Be sure that at the end of the day, once business has 

stopped, to review this report to ensure all contracts have 

been entered and are correct, and all transactions have been 

entered for the right amount and to the right account. This 

is far easier to do when you are only looking at one day’s 

worth of information that is still fresh in everyone’s mind. 

The old saying garbage in, garbage out is relevant here as 

now is the time to prevent this. It’s important to take 15 

minutes to check this report each day. Even if that means 

you find something that maybe you can’t fix immediately, 

there is nothing wrong with waiting to finalize the next 

morning. All reports that are based on the Daily Transaction 

Reports are based on the report numbers, not dates. This is 

important to remember.

Transaction Report Log
Another very useful report is the Transaction Report Log. 

This report gives you the report number, time stamp, and 

the operator of every finalized transaction report within the 

date range you set. This is useful to make sure that there is a 

finalized transaction report for each day within a given date 

range. There are many reports that are based on finalized 

transactions, so it is important to ensure each report you are 

expecting to be finalized is.

Transaction Summary 
The big one is the Transaction Summary report. This is 

essentially just a daily transaction report but for a given date 

range, normally a month or a year. Most people view this 

report by just plugging in the date range they are interested 

in and calling it good. But it is always a good idea to double-

check the Transaction Report Log first to make sure that you 

have finalized all the reports that you are interested in. This 

is where it can be better to use the report numbers instead 

of a date range to filter information. 

Transactions by Type
Another useful report that is based on transaction reports 

is the Transactions by Type report. This report gives you 

the option to isolate a particular type of transaction. For 

example, you can see all your cash transactions for a given 

month. One of my favorite uses is to look up adjustments. 

This report allows you to see each time a particular 

adjustment type was used and for what dollar amount. This 

comes in useful in an infinite number of ways. From the 

number of paid-in-full discounts you give out to how much 

you are writing off in bad debt. You can see each patient 

and the amount of the adjustment given. 

Posting Date Based Reports
There are three reports that I want to talk about that are 

not based on finalized transaction reports. They are the 

A/R Aging report, Contract Totals, and Charge and Receipt 

Summary report. These are great reports, but they are not 

comparable to the aforementioned reports that are based 

on finalized transaction reports. 

These reports are based on the posting date or the date you 

enter into the system when you input the data. This could 

be the start date of a contract or the posting date of a credit 

card transaction. This can be useful for many reasons, versus 

basing a report on finalized transaction reports. Finalized 

Sean has worked at Ortho2 for the last 13 years and has always 
enjoyed the ever-changing challenges that the software industry has 
to offer. When he’s not working, Sean enjoys watching Iowa State 
football and basketball with his wife (who he met at Ortho2) and their 
three-year old daughter, Arlette. 

Sean Gildersleeve 

Contact Info: ortho2support@ortho2.com • 800.346.4504

Financial Reporting in Edge Cloud

transaction reports are just that, final, meaning they cannot 

be changed once finalized. Any mistake you may make 

is permanently part of the report. You see why it is so 

important to make sure they are correct before you finalize. 

This is also useful if you are entering in contracts earlier than 

when a patient officially starts treatment. For example, you 

can enter the contract today but add the start date as next 

week when the patient comes in for their first appointment. 

A transaction report-based report is going to show this 

as production 

for today, and a 

posting date-based 

report will show 

this as production 

for next week. 

The same can be 

said if you have a 

patient who hasn’t 

started treatment 

but a contract 

has already been 

entered. A posting 

date-based report 

would update 

once the contract 

has been deleted. 

Now, these are not 

common things, 

but they can and do happen, probably more than you think.

A/R Aging
An A/R Aging report is most useful for looking up 

delinquent accounts. Normally, this report is subgrouped, 

or some kind of filter is applied to only give you certain 

patients. The A/R Aging report is important as it can give us 

past due accounts and a list of patients that we may need to 

contact to set up a payment plan or accounts that are a lost 

cause and need to be written off. This is important as these 

accounts can falsely inflate other production-based reports.

Contract Totals
The Contract Totals report is a basic report that gives you all 

contracts that have a start date within 

the date range you set. Just a clean, 

simple look at contracts. This report 

can also be subgrouped for any 

number of reasons: based on patient 

status, age, zip code, and or any 

other data point in Edge Cloud. 

The Charge and Receipt report is 

a great report, but there is some 

confusion on what information it is 

displaying and how it gets there. This 

is a posting-date report, meaning 

contracts are calculated by start date 

and receipts and adjustments are 

calculated by posting date. Then 

there are two sections to this report, 

Sections A and B. Section A calculates 

the total amount of the contract 

as of the start date. This means that for a $5,000 contract 

that has a start date of January 1, section A will show the 

whole $5,000 as production as of January 1. Section B gets 

a little more interesting as it reflects the individual charges 

as they are posted. So, let’s go back to the $5,000 contract. 

Financial Reports continued on page 10
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Joan can be described as one 
who “walks her talk.” She is 
a premier change agent who 
is dedicated to her work and 
her clients. Throughout the 
past 34 years, Joan has led 
more than 2,500 seminars on 
effective communication, public 
speaking skills, team building, 
and customer service. She has 
facilitated hundreds of practice 
owners in achieving their goals 
and trained their employees 
in turning the patients into a 
powerful volunteer sales force.

Joan Garbo
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joangarbo@aol.com 
joangarbo.com

Simple Service

Alisha grew up in orthodontics. 
From her first job out of high 
school as a dental assistant, 
to business manager, she has 
worn every hat from scheduling 
to insurance to TC – Alisha has 
seen it all. As a TC, she learned 
firsthand what works and what 
doesn’t in a modern ortho office.

Now, Alisha brings all the 
insights gained as a world-class 
sales leader, combined with a 
natural gift for fostering thriving 
patient-team communities to her 
work at Straight Consulting.

Alisha Holbert

Contact Info: 

alisha@straightconsulting.com 
straightconsulting.com

How Leadership and Coaching Can Take 
Your Ortho Practice from Meh to Thriving

P roviding good service to 

patients, customers, and 

clients is not difficult. Countless 

books have been written about 

how to do this. Essentially, 

they are rooted in the basics 

of service identified by the Ritz 

Carlton Hotels in the early 90s:

Three Steps of Service

1.	 A warm and sincere 

greeting. Use the guest’s 

name if and when possible. 

2.	 Anticipation and compliance 

with guest needs. 

3.	 Fond farewell. Give them 

a warm good-bye, and use 

their names if and when 

possible.

In my work with clients, I have 

adjusted the above to be: 

1.	 SMILE! After all, you are in 

the smile business. 

2.	 Use the patient’s name 

whenever possible. 

3.	 Maintain good eye contact. 

4.	 Listen! If you maintain eye 

contact, you will also hear 

what is not being said and 

will be able to meet requests 

before the person asks. 

Simple! So why is it often absent? 

For example, a couple of weeks 

ago, I was shopping at the local 

grocery store and went through 

the checkout line with a real 

person racking up my purchases. 

As she was sliding the items over 

the scanner, I started bagging 

them. She finished scanning 

and then leaned back on the 

ledge behind her with her arms 

crossed. There were at least 

four customers lined up behind 

me waiting to check out. I had 

to ask her to help me bag the 

items, which she did with what 

seemed to me to be annoyance. 

As we finished, I asked her if 

she was new at this job and she 

simply said “No.” Besides not 

offering to bag the items, she 

also did not offer a smile, make 

eye contact with me, or thank 

me for my patronage. And she 

apparently had no concern for 

the other customers waiting to 

check out.

In the total scheme of things, 

this is no big deal. It also has not 

been a deal breaker for me as I 

have continued to shop there for 

reasons that have nothing to do 

with the attitude of the checkout 

lady. (Also, I can avoid having 

contact with her again by using 

self-checkout or going to another 

line.) 

Unfortunately, this is not an 

isolated incident since I have 

noticed a consistent lack of the 

Service continued on page 10

I n today’s orthodontic world, having strong clinical skills is just 

one piece of the puzzle for running a successful practice. Sure, 

delivering great treatment results is essential, but there’s more to it 

than that. Your practice also needs a solid, coordinated team who 

knows how to work together like a well-oiled machine. Getting to 

that point takes thoughtful leadership and a commitment to ongoing 

coaching.

Unfortunately, many orthodontic practices focus so heavily on clinical 

training and technology that they overlook leadership and team 

development. When there’s no clear leadership or formal coaching 

in place, inefficiencies creep in, communication breaks down, and 

turnover skyrockets. As you can imagine, it doesn’t take long for 

patient experiences and case acceptance rates to drop.

In an increasingly competitive field, orthodontic leaders have to 

step up as vision-setters and actively invest in their team’s growth. 

Leadership points everyone in the right direction, while coaching 

helps each team member confidently carry out the plan. By making 

leadership and coaching a priority, you’ll build a culture that’s both 

productive and rewarding – paving the way for long-term success.

Leadership: More Than Just a Title
When we talk about leaders in an ortho practice, the first person who 

comes to mind might be the orthodontist or practice owner. But in 

reality, effective leadership is a team-wide effort. Great leaders don’t 

just make the big decisions – they also inspire, empower, and set an 

example.

The difference is palpable when there’s strong leadership at every 

level; team members feel valued and confident in their roles and the 

overall morale is high. On the flip side, if leadership is lacking, you’ll 

see confusion, inefficiency, and employees who are basically just going 

through the motions. Look at any successful ortho office and you’ll 

find leaders everywhere – from the office manager to the treatment 

coordinator – who understand communication, accountability, and the 

importance of empowering their colleagues.

Leadership continued on page 12
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With 40+ years of experience working and consulting in the field of 
orthodontics, Tina Byrne has gained success and recognition for her 
well-founded proficiencies in clinical, business, and administrative 
functions. She has extensive knowledge and understanding of 
systems innovation and efficiency, data analysis, strategic business 
planning, and marketing implementation. 

Tina Byrne

Contact Info: tinabyrne@byrne-consulting.com, byrne-consulting.com

Unlock Your Potential –  
The Ultimate Edge

A s an orthodontic practice consultant with more 

than 25 years of consulting experience, I have 

had the privilege of working with hundreds of practices 

and thousands of team members. One of the greatest 

challenges in this field is shifting a team member’s 

perception when discussing role expansion, especially 

when they already feel overwhelmed by their current 

responsibilities. Helping them develop the skills to enhance 

efficiency and effectiveness is deeply rewarding. However, 

the most gratifying moment comes when I introduce 

them to the powerful tools and resources already at their 

fingertips – hidden efficiencies they never realized they had 

– unlocking new levels of confidence and capability.

For this reason, I want to highlight some of my favorite 

features within Ortho2’s Edge Cloud platform; solutions 

designed to streamline workflows, improve productivity, 

and empower team members to work smarter, not harder. 

These tools not only simplify daily tasks but also create 

opportunities for growth, helping teams maximize their 

potential with greater ease and effectiveness.

Tasks: Maximizing Efficiency and 

Accountability
Not everyone is a natural multi-tasker; in fact, very few 

people are. Yet, in the fast-paced environment of an 

orthodontic practice, team members are constantly juggling 

responsibilities, including crucial follow-ups for the office, 

patients, and third parties. So what’s the key to staying 

organized and ensuring nothing falls through the cracks? 

Ditch the sticky notes!

By leveraging tasks, you can establish a fail-proof system 

for tracking obligations – whether they belong to you, 

a fellow team member, a patient, or even an insurance 

carrier. Tasks serve as built-in reminders, keeping everyone 

accountable and streamlining communication across the 

practice. Instead of relying on scattered notes or memory, 

you can create, assign, and monitor tasks efficiently, leading 

to improved productivity, reduced stress, and a smoother 

workflow for the entire team.

Workflows: The “Automated 

Intelligence” You’ve Had All Along
Imagine having a built-in assistant that ensures no critical 

step is overlooked. That’s the power of Workflows within 

Edge Cloud. This automation tool has been at your 

fingertips all along, silently waiting to transform the way 

your practice operates.

From automatically updating a patient’s status field to 

triggering reminders or messages when scheduling specific 

procedures, Workflows act as your practice’s fail-safe 

system. Whether it’s prompting a team member to confirm 

financial details, ensuring timely patient communication, or 

seamlessly routing a patient’s name to another department 

via stack entry, Workflows remove the guesswork and 

manual follow-up.

Gone are the days of missed emails, overlooked letters, or 

forgotten follow-ups. With Workflows, your team can work 

smarter, not harder, enhancing efficiency, accuracy, and 

patient experience while reducing stress and human error.

Stacks: The Digital Solution to 

Seamless Task Routing
For those who have been in orthodontics for more than a 

decade, the challenges of managing paper charts are all too 

familiar. Moving a chart from place to place, or from team 

member to team member, was once the standard method 

for ensuring tasks were completed in sequence. While 

checklists attached to charts helped guide the process, they 

often led to frustrating scavenger hunts when a chart was 

misplaced or urgently needed.

Thankfully, Edge Cloud’s Stacks eliminates these 

inefficiencies by bringing chart routing into the digital era. 

Much like their paper predecessors, Stacks organizes and 

tracks patient tasks, but with a critical difference – they can 

never be lost or forgotten. With Stacks, tasks flow in multiple 

directions at any given time, ensuring that necessary actions 

are clearly assigned, easily accessible, and seamlessly 

completed by the right team members.

No more misplaced charts. No more bottlenecks. Just a 

smarter, more efficient way to keep 

patient workflows moving smoothly, 

exactly when and where they’re 

needed.

Subgroups: Precision in 

Patient Management
One of the first things I assess when 

working with an orthodontic practice 

using Edge Cloud is their custom 

subgroup setup. Why? Because the 

way a practice filters and organizes 

patient data speaks volumes about its 

efficiency and workflow optimization.

If my review reveals only the standard 

folders and subgroups that come with 

the system, I immediately see a huge 

opportunity to elevate the practice’s 

efficiency, productivity, and patient 

communication.

Subgroups are the key to precision in patient management, 

allowing practices to go beyond generic lists and drill down 

into the most specific patient situations. This functionality 

enables teams to:

•	 Generate Highly Targeted Reports: Quickly access the 

exact data you need.

•	 Create Real-Time Dashboards: A simple refresh puts 

up-to-the-minute insights at your fingertips.

•	 Enhance Patient Communication: Automate outreach 

for specific patient needs based on 

predefined conditions.

By leveraging custom subgroups, your 

practice gains better organization, 

clearer insights, and the ability to take 

highly specific actions—all in a way that 

feels effortless.

Scheduler Bar: Keeping 

Active Patients Front and 

Center
The Scheduler Bar is a powerful tool for 

keeping unscheduled patients visible 

and prioritized, but only when it is 

properly utilized and managed. When 

structured effectively, it becomes a 

game-changer in maintaining treatment 

timelines, balancing the schedule, and 

Ultimate Edge continued on page 14
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Financial Reports continued from page 5 Service continued from previous page

Let’s say this contract has an initial fee of $1,500 that is due 

on January 1 and period fees of $250 due on the first of the 

month starting on February 1. If I were to run the Charge and 

Receipt report for January, section B would only show the 

$1,500 dollars that is due, whereas Section A would show the 

whole $5,000. So think of Section B as more what is owed to 

you during the period you set, whereas Section A is more a 

reflection of overall production during this period. Remember, 

this also means that Section B will reflect period fees due in 

January from contracts started much earlier. This is similar 

to a Transaction Summary report, but it doesn’t care if the 

transactions are on a finalized report or not. 

This is just the tip of the iceberg of financial reporting, but 

these are the most common ones to run to get a finger on the 

heartbeat of your practice. In next quarter’s newsletter, I will 

dive into insurance and appointment-based reports and some 

tips and tricks that can apply to any report in Edge Cloud.  

very basics of service in almost every 

industry with which I have interacted: 

cell phone carriers, clothing stores, 

various doctor offices, restaurants and 

delis, and the list goes on. 

While there seems to be a sense of 

malaise among a significant portion of 

workers, it is unwittingly supported by 

the explanation that people are not 

paid enough, these are dead-end jobs, 

inflation has diminished their buying 

power, and a host of other reasons 

owing to the circumstances of life that 

essentially reduce one to being a victim 

in life.

WARNING: DO NOT BUY INTO THAT! 

Circumstances do not determine your 

sense of joy, satisfaction, and fulfillment 

in life. Your reaction/interpretation 

of the circumstances are the key to 

your happiness and are totally in your 

power! If you rely on external forces, 

people, and things outside of you in 

order to be happy or satisfied, you 

unwittingly become subject to the 

winds of time in order to be happy. 

There are countless examples of 

people who have been born into or 

swept into dire circumstances and have 

risen above them to create outstanding 

success for themselves and have used 

their experiences as platforms for 

success.

One of the more inspiring and 

poignant examples of this is Viktor 

Frankl, a German psychiatrist who 

survived imprisonment in two Nazi 

concentration camps. After his rescue 

in 1945, he wrote a bestselling book, 

Man’s Search for Meaning. In it he 

states, “Everything can be taken from 

a man but one thing. The last of human 

freedoms is to choose one’s attitude 

in any given set of circumstances.” 

He had suffered unimaginable loss 

and pain at the hands of the Nazis; 

yet he came to the realization that 

they cannot take away his freedom to 

choose his response. He further writes 

in his book that, “Between stimulus 

and response there is a space. In that 

space is the power to choose our 

response. In that power lies our growth 

and our freedom.” 

Fortunately, most of us will never 

be confronted with such dire 

circumstances; and I think it is 

important to take Frankl’s lesson to 

heart and apply it to our ‘ordinary’ 

lives. 

The average person spends 35 or 

more hours each week at work. It is 

important that your work experience 

supports your well-being beyond the 

size of your paycheck. In my world, 

you cannot get paid enough to suffer! 

While many jobs may appear to be 

more rewarding, important, fun, 

meaningful, etc., the truth is all work is 

important and can be all of the above 

by virtue of a person’s interpretation 

about the job, not the job itself. To 

quote Henry Giles,

“Man must work. That is certain as the 

sun. But he may work grudgingly or he

Looking for EDGEucational content to help you become an Edge Cloud guru? Our brand new 
EDGEpisodes series is perfect for you! These bite-size videos will provide you with quick and 
easy tips to master all things Edge Cloud and are easily accessible on Facebook and Instagram.

EDGEucate Yourself With EDGEpisodes

may work gratefully; he may work as a man, or he may work 

as a machine. There is no work so rude, that he may not 

exalt it, no work so impassive, that he may not breathe a 

soul into it, no work so dull that he may not enliven it.”

Orthodontics provides a unique opportunity for people 

to experience a sense of fulfillment and satisfaction while 

working in great environments, doing meaningful work, 

participating with teammates in fun activities, expanding 

education both in personal and professional lives, while 

earning good salaries and benefits. 

Despite this background, I know that work can be stressful: 

some people are difficult to please; some co-workers do 

not always pull their own weight; personal issues outside 

of work can bring someone down; mistakes can mess up a 

schedule; patients come late and expect to be seen and are 

argumentative; and the list goes on. In other words, we do 

not live in Utopia with unicorns and daisies, and we are all 

human! 

This is where Frankl’s message is so important. Between 

stimulus and response there is a space, and in that space, 

you can choose your response, rather than just react. Use 

the basics of service to make smart choices to the stimulus: 

make eye contact and LISTEN before you speak. If you are in 

a bad mood, SMILE! Science has found that a smile releases 

endorphins, dopamine, and serotonin, which then can 

reduce stress, improve heart beats, and boost energy. And 

when you smile, it has the same effect on anyone who sees 

you smiling and often creates a smile in them as well.

In what I am now calling ‘Frankl’s space’ there is the power 

to choose your interpretation of the situation. Renowned 

motivation speaker Zig Ziglar told the story of a problem 

at the Phoenix airport one day. The scheduled flight had 

been canceled for some reason, and all the passengers 

were lined up waiting to speak with just two ticket agents to 

rebook their flights. As you can imagine, there were many 

upset people and not all were pleasant with the agents. 

When Ziglar approached the agent he said, “How are 

you?” and the young man barely looked up at Ziglar and 

tersely replied, “Not good, terrible in fact.” And Ziglar said, 

“Compared to what? You’re in an air-conditioned building, 

doing work that is not strenuous, wearing a professional 

uniform…you’re not repaving roads in the hot sun or 

standing on an unemployment line waiting for a handout.” 

The agent stopped and looked at Ziglar and said, “Yes sir! 

You are so right. Thank you!” His shift in attitude benefited 

everyone else he worked with that day. Besides rebooking 

flights, he provided real service to the passengers; and I 

suspect, he went home feeling like he had had a good day. 

Two other observations: First, when you provide service 

to others, you are actually serving yourself. Life acts as a 

boomerang; what comes back at you is what you have put 

out there. 

Second, because the general sense of malaise regarding 

work is so prevalent, following the simple service steps sets 

you apart and creates raving fans. 

Finally, I leave you with a quote from Dr. Albert Schweitzer, 

noted humanitarian, “I don’t know what your destiny will be, 

but one thing I know: the only ones among you who will be 

really happy are those who have sought and found how to 

serve.”

And SMILE! 

Service continued from page 6

Service continued on next page

By Phone: 800.346.4504

By Email: ortho2support@ortho2.com

And Don’t Forget Our Website:  
support.ortho2.com

Available 7:00 A.M. – 7:00 P.M. Central Time, Monday – Friday 

Response time is usually the same day or at most within 24 hours.

Our website gives you 24/7 access to our knowledge base, FAQs,  
white papers, visual help videos, and more.

Contact Support
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Leadership continued from page 7

Five Key Leadership Traits

1.	 Clarity of Vision: Make sure everyone is on board with 

the mission and big-picture goals.

2.	 Accountability: Own up to mistakes and address issues 

head-on instead of playing the blame game.

3.	 Empowerment, Not Micromanagement: Equip your 

team with the right tools and trust them to do their jobs.

4.	 Communication and Transparency: Keep everyone in 

the loop and be upfront about challenges.

5.	 Adaptability: In a rapidly changing field, the ability to 

pivot or innovate can make all the difference.

Coaching: The Secret Sauce of a 

High-Performing Team
Leadership is the compass that sets the course, but 

coaching is what keeps the ship on track. It’s an ongoing 

process of refining skills, boosting confidence, and helping 

team members perform at their best. Without coaching, 

employees can get stuck, feel overwhelmed, or struggle to 

meet expectations.

In the best-run orthodontic offices, coaching is baked into 

the culture; regular training, mentorship, and feedback aren’t 

just reserved for when something goes wrong. By making 

coaching a priority, you’ll see:

•	 Stronger Collaboration: Everyone knows how their role 

fits into the bigger picture, creating better team synergy.

•	 Higher Case Acceptance: Well-coached treatment 

coordinators nail financial conversations and convert 

consults into starts.

•	 Improved Efficiency: Assistants and front-desk team 

members learn how to perfect their workflows, which 

cuts down on wasted time.

•	 Better Patient Experience: A team that’s confident and 

well-supported delivers top-notch service.

•	 Lower Turnover: People stick around when they feel 

challenged, supported, and appreciated.

What Should You Coach Your Team On?
1.	 Communication and Patient Experience

Every interaction shapes your patients’ perception of 

your practice. Coach the front desk team on friendly 

greetings and confident phone conversations, train 

treatment coordinators on financial presentations, and 

help clinical assistants strengthen their chairside manner. 

Don’t forget a smooth hand off between departments – 

little details like that can make a huge difference.

2.	 Case Acceptance and Financial Conversations

To thrive, your practice needs to convert consultations 

into actual treatment starts. That means teaching your 

treatment coordinators to present financial plans in a 

straightforward, positive way and preparing them for the 

most common patient objections. The more comfortable 

they are, the more likely patients are to say “yes.”

3.	 Time Management and Workflow Efficiency

Running behind schedule irritates both patients and 

team members. Simple coaching around time-blocking, 

refining chairside procedures, and sharpening scheduling 

techniques can dramatically reduce bottlenecks and 

keep appointments flowing smoothly.

4.	 Leadership Development at Every Level

Leadership isn’t just for the boss. Train your treatment 

coordinators, lead assistants, and office managers on 
giving and receiving feedback, resolving conflicts, and 

taking initiative. When every member of the team steps 

up as a leader, you’ll notice higher productivity, better 

morale, and fewer headaches all around.

Building a Coaching Culture
If you want coaching to stick, make it part of your regular 

routine. Weekly team huddles, one-on-one check-ins, and 

role-playing exercises help keep everyone on the same 

page. Encourage your senior team members to mentor 

newbies and set aside a budget for continuing education 

– whether it’s through industry conferences, webinars, or 

leadership workshops.

Ready to Thrive? Start With Your Team
If your orthodontic practice feels bogged down or chaotic, 

the issue might not be your scheduling software – it could 

be a lack of leadership and coaching. A well-led, well-

coached team is the backbone of any thriving office. With 

a clear vision and the right support, your team will be more 

efficient, your patients will be happier, and your practice will 

steadily grow.

Rather than pouring all your resources into marketing or the 

latest tech gadget, remember to invest in your people first. 

Because when your team is thriving, so is your business. 

Leadership continued from previous page

Microsoft is ending support for Windows 10 in October 2025. You should not take this matter lightly. If 
you have not updated your operating system by October, you will no longer be HIPAA or PCI compliant 
if you accept payment by credit cards. New computer viruses and other malware are developed all the 
time and, without the security updates to fight them off, your data and your system are vulnerable.

Contact the Network Engineering Team today at engineering@ortho2.com, or 800.346.4504, option 2 to 
discuss the best path forward.

Windows 10 End of Life

Leadership continued on next page

Don’t just like
your software.

Love it.

We all like ViewPoint, but we know you are 
going to love Edge Cloud. And in the city of 
brotherly love, get the best deal of the year!

AAO Sale | Save $2,000

  Terms and restrictions apply. Offer expires April 27, 2025.
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Forty-Three Years
Dan Sargent

Thirty-Four Years
Diane Lyon

Twenty-Seven Years
Coreen Magnuson 

Mike Vest

Twenty-Six Years
Doug Olsan

Twenty-Four Years
Joe Levenhagen

Twenty-Three Years
Danetta Hiatt 

Amy Schmidt

Twenty-One Years
Chad Kellner 

Tony Kooima

Nineteen Years
Chris Bennett

Sixteen Years
Jim Powell

Fourteen Years
Mike Gude

Thirteen Years
Mark Hoffmann

Eleven Years
Lori Backous 

Linda Cooley 

Amia Sult 

Six Years
Joe Randazzo

Four Years
Kimberly Betke

Three Years
Noah Parks

Two Years
Monica Duarte 

Montana Horras 

Leslie Mehalek 

Jordan Neumayer

One Year
Kay Duran 

Anthony Vieger

Celebrating Ortho2 Anniversaries

Congratulations to these Ortho2 team members who celebrated anniversaries during the first quarter of 2025

The Cutting Edge Webinar Series features industry-leading 
consultants and doctors presenting on their expertise in the 
field. These webinars are free and for anyone - from resident to 
experienced doctors and staff. 
 

Scan the QR code for a full calendar of 
webinars and recordings. Webinar recordings 
can be found at the bottom of the page and 
will be available for three months after the 
webinar takes place.

Free Cutting Edge Webinar Series

Please be prepared to provide your customer number, practice name, and office location when you call our 
support teams for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you 
use ViewPoint, you will find your customer number by clicking the Help menu and choosing About. Please be sure 
to provide this information—and repeat your phone number—when leaving a phone message requesting support. 

Help Us Help You

preventing unnecessary delays in patient care.

Proactive Strategies for Managing the Scheduler Bar

•	 Automate Weekly Reminders: Set up automated 

emails and text reminders for unscheduled patients, 

reinforcing the importance of staying on track with their 

treatment.

•	 Monitor Weekly to Take Action: The Scheduler Bar 

isn’t a “set it and forget it” tool. It should be actively 

managed on a weekly basis.

•	 Analyze Impact on Schedule Capacity: The number 

of unscheduled active patients directly impacts overall 

scheduling demand.

By strategically using the Scheduler Bar, automating patient 

reminders, and proactively managing scheduling demand, 

your practice can stay ahead of unscheduled patient 

overload while keeping treatment progress on track and the 

schedule running smoothly.

Dashboard: Every Team Member’s 

Control Center
The Dashboard is an invaluable tool that allows team 

members to customize reports, lists, tasks, and essential 

patient information all in one central hub. When utilized 

effectively, it enables teams to prepare, review, and execute 

their workload with ease and efficiency, keeping daily 

operations streamlined and organized.

Maximizing Your Dashboard for Productivity

•	 Identify daily, weekly, or monthly tasks requiring reports 

or lists.

•	 Customize the Dashboard to reflect the most relevant 

information.

•	 Use subgroups for smarter list management and clearer 

patient insights.

Unlocking the Full Potential of Your 

Practice Management Software
With decades of experience working alongside orthodontic 

teams as a coach and consultant, I can confidently say that 

most practices utilize only 50-60% of the functions available 

within their practice management software. This means 

that a significant number of powerful tools and efficiencies 

remain untapped—tools that could streamline operations, 

improve patient care, and enhance overall productivity.

Ortho2’s Edge Cloud offers unique features and functionality 

not found in any other practice management system. The 

question is: What’s your current utilization percentage?

Increasing your utilization by just 10% can have a 

transformative impact on your practice. Not only will it 

enhance efficiency and workflow, but it will also ignite a 

drive to explore even more ways to optimize performance 

and elevate patient experience.

The potential is already in your hands—are you ready to 

unlock it? 

Ultimate Edge continued from page 9

Do you need to call in to our Support Team for a question, but it’s difficult to wait on hold, 
even for a few minutes? Ortho2 has you covered! Use our chat support to get in contact 
with us. When you use the chat support feature, you will be added to the same queue as 
phone calls. You can choose to chat with the Software Support, Implementation, or Network 
Engineering Teams. 

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint, click 
the Help button in the bottom right of the Daily Activities menu.

Chat Support
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